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About this Guide

About this Guide
This guide provides information on service testing options of Integration Server using
webMethods Test Suite. The scope of this document is to introduce the suite, design and
execute test cases.
It is assumed that the user is familiar with the standard build and test tools such as, Ant
and JUnit.

Document Conventions
Convention

Description

Bold

Identiﬁes elements on a screen.

Narrowfont

Identiﬁes service names and locations in the format
folder.subfolder.service , APIs, Java classes, methods, properties.

Italic

Identiﬁes:
Variables for which you must supply values speciﬁc to your own
situation or environment.
New terms the ﬁrst time they occur in the text.
References to other documentation sources.

Monospace
font

Identiﬁes:

{}

Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

|

Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[]

Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

...

Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).

Text you must type in.
Messages displayed by the system.
Program code.
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Online Information and Support
Software AG Documentation Website
You can ﬁnd documentation on the Software AG Documentation website at “hp://
documentation.softwareag.com”. The site requires credentials for Software AG's Product
Support site Empower. If you do not have Empower credentials, you must use the
TECHcommunity website.
Software AG Empower Product Support Website
If you do not yet have an account for Empower, send an email to
“empower@softwareag.com” with your name, company, and company email address
and request an account.
Once you have an account, you can open Support Incidents online via the eService
section of Empower at “hps://empower.softwareag.com/”.
You can ﬁnd product information on the Software AG Empower Product Support
website at “hps://empower.softwareag.com”.
To submit feature/enhancement requests, get information about product availability,
and download products, go to “Products”.
To get information about ﬁxes and to read early warnings, technical papers, and
knowledge base articles, go to the “Knowledge Center”.
If you have any questions, you can ﬁnd a local or toll-free number for your country
in our Global Support Contact Directory at “hps://empower.softwareag.com/
public_directory.asp” and give us a call.
Software AG TECHcommunity
You can ﬁnd documentation and other technical information on the Software AG
TECHcommunity website at “hp://techcommunity.softwareag.com”. You can:
Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.
Access articles, code samples, demos, and tutorials.
Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.
Link to external websites that discuss open standards and web technology.
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Overview
Test Suite is an Eclipse based testing tool that allows developers to create unit tests for
their development. These tests improve the overall development quality and provide a
mechanism to create automated tools for continuous integration and delivery.
Test Suite provides the following functionalities:
Provides service unit testing and regression testing tools that allows service
developers to assemble unit tests without the need for additional development
Enables integration with JUnit to leverage a standard unit testing framework, which
already works well with Continuous Integration tools
Enables ease of use for test development
Provides a Java API for advanced users to create JUnit test cases
Provides a user interface that is integrated in Software AG Designer. Software AG
Designer ensures that users do not switch between tools for services development
and corresponding test cases
Provides a mechanism to repeatedly execute the service with same inputs and
compare the results with an expected set of outputs
Provides a framework for mocking service execution for steps that cannot be
executed during the testing. For details, see “Using Mocks ” on page 32

Terms and Concepts
This section provides information on the terms and concepts used to understand Test
Suite.

Services
The webMethods Integration Server hosts packages that contain services and related
ﬁles. The server contains several packages.
For example, Packages that contain built-in services, which can be invoked from
services or client applications and services that demonstrate features of the webMethods
Integration Platform.
You can create additional packages to hold the services that your developers create.
Developers can create services that perform functions, such as, integrating your business
systems with those of your partners, retrieving data from legacy systems, and accessing
and updating databases.
Integration Server provides an environment for the orderly, eﬃcient, and secure
execution of services. It decodes client requests, identiﬁes the requested services, invokes
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the services, passes data to them in the expected format, encodes the output produced
by the services, and returns output to the clients.

Pipeline
Pipeline refers to the data structure in which input and output values are maintained for
a ﬂow service. It allows services in the ﬂow to share data.

Pipeline starts with the input to the ﬂow service and collects inputs and outputs from
subsequent services in the ﬂow. The service in the ﬂow has access to all data in the
pipeline at that point.
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Unit Testing
Test Suite uses the concepts of service execution, pipeline data, and the open source
JUnit testing framework to provide unit testing functionality for Integration Server Flow
and Java services. Test Suite provides the ability to create a suite of tests consisting of
individual test cases. Each test case deﬁnes a service to be tested, the type of test to be
performed, and provides a user interface to deﬁne input data to the test case through
the pipeline. When the service execution is completed, the pipeline output is validated
against the expected output deﬁned in the test case.

Test Case
A test case is a unit of testing for a service that provides:
service to be tested
inputs to the service
expected output from the service
A test case can also deﬁne expected output from a service as an exception or error. The
service returns the deﬁned errors when incorrect data is sent to it.

Test Suite
A test suite is one or more test cases grouped together. Test suites are used to organize
test cases into sets of related tests. For example, a service may provide a variety of
capabilities based upon the inputs provided to it. A complete test suite should include
test cases that provide inputs that fully test all of the possible outputs of the service,
including errors or exceptions.

Mock
Mocks provide a means of simulating interaction with resources that are unavailable
or the data provided by these resources or systems is not consistent for test purposes.
Mocks also have a lifetime that can either be limited to the test case in which they are
deﬁned or applied to all of the test cases that follow within a test suite from the point of
the deﬁnition.
Mock intercept can control the session, user, and server based on the scope seing. If the
scope is set to session, the test sessions will be aﬀected by the mock. It is recommended
to set the scope to session for most users. If the scope is set to user, all the sessions for the
particular user will be aﬀected by the mock. If the scope is set to server, all user sessions
will be aﬀected by the mock. Mocks can be enabled or disabled for test case or test suite
execution.
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Service Mock
A service mock is used to replace the call to a service with a call to a diﬀerent service.
Any call to the mocked service is intercepted and the alternate service deﬁned in the
mock is called instead. The output of the mocked service is then returned to the calling
service. This kind of mock is useful when the output of the mocked service needs to be
dynamic based on some logic that can be created in the service.

Exception Mock
An exception mock is used to return an error or exception to the calling service and can
be useful for testing error handling in a service. As with the other mocks described, any
call to the service deﬁned in the mock is intercepted and the exception deﬁned in the
mock is returned instead. This kind of mock is useful to simulate behavior that can cause
exceptions in the normal ﬂow.

Factory Mock
A factory mock is used when a call to a service produce multiple diﬀerent outputs based
on the provided input. A factory mock is implemented as a Java class. Any call to the
class deﬁned in a factory mock is intercepted and the input is passed to the factory
which evaluates the input and returns the appropriate results. While both the factory
mock and the service mock options provide dynamic output simulation, the factory
mock does not require an extra test service to be created on the server and relies on a
lightweight java implementation.

Capabilities
Test Suite has following capabilities:
Unit testing
Mock testing
Regression testing
Unit testing
Test Suite is a unit-testing tool. You can design, build, and execute unit test cases using
Eclipse User Interface. You can also execute the test cases externally using Ant scripts.
Mock testing
Mocking is a feature that mimics the functionality of services that are dependent on
external resources. When a test case encounters a service that is mocked, it executes the
service.
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Regression testing
You can save the test cases, along with their inputs and outputs, in xml ﬁles. Run the
reusable artifacts to ensure that the latest changes do not reintroduce the errors ﬁxed in
the earlier versions.

Server Definition
Integration Server preferences in Designer describe the connection to for Test Suite.
Designer always uses the active default Integration Server deﬁnition for Test Suite.
Secure connection option in default server deﬁnition indicates whether the session will
be opened through HTTP or HTTPS. In Designer, navigate to Window > Preferences >
Software AG > Integration Server to add, edit, and update connection conﬁgurations. For
details, refer the webMethods Service Development Help.
The editor does not always require an active connection to the test development. But
some of the introspection features that allow service lookup and service signature
are not available if a connection is not available and so, the user should enter them
manually.

Environment
Option

Description

Hardware
Requirements

No additional hardware is required other than the ones that are
already in use for Integration Server and Software AG Designer.

Software
Requirements

Developer Installation Requirements
Unit Test Framework Eclipse plug-in (Designer > Services > Unit
Test Framework)
WmServiceMock package for Integration Server (Integration
Server or Microservices Runtime Packages > Unit Test Framework)
Unit Test Framework Software AG Designer plug-in can work
with both Local and Remote Integration Server.
Continuous Integration Installation Requirements
WmServiceMock package for Integration Server (Integration
Server or Microservices Runtime Packages > Unit Test Framework)
Unit Test Framework libraries (Infrastructure > Libraries > Unit
Test Framework Libraries)
Ant Build tool 1.7 (optional)
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Option

Description
JDK 1.8 or later

Version
This suite depends on open source products like Ant and JUnit.
Compatibilities
Following are the supported versions:
Ant: 1.7
JUnit: 4.11
Unit Test Framework works with all the currently supported
General Availability (GA) versions of Integration Server and
Software AG Designer.

What it is not
Test Suite is not an integration or system test platform. However, this suite is used to
mock the application dependencies and simulate the integration or system test.
Test Suite is not a performance-testing tool. It cannot be used for performance, load,
or volume testing.
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Opening the Unit Test Framework Perspective
Software AG Designer provides a Unit Test Framework perspective that contains the
views, editors, and tabs needed to build test suites and other supporting elements.
1. In Designer, select Windows > Open Perspective > Other.
2. In the Open Perspective dialog box, select Unit Test Framework and click OK.
Designer switches to Unit Test Framework perspective.

Layout
The ﬁgure below shows various components of Software AG Designer with a test suite
ﬁle open for editing.

Use the following icons on the toolbar to tailor the layout.
Icon

Description
Allows you to place the Master and Details views next to each
other, master on the right and details on the left.
Allows you make the master appear at the top of the display,
and the details view gets aligned underneath it.
Allows you to toggle the display between the master and details
views, each occupying the entire display. Click again to return to
the original layout .
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Test Suite Preferences
To display the preferences dialog box, select Window>Preferences>Sotware AG>webMethods
TestSuite.

Advanced
The Advanced preferences control other behaviors of Test Suite.
Preference

Description

Use Relative
Paths in
Filenames

Makes ﬁle name references relative to the Eclipse project
containing the test suite rather than using the full path. Using
relative names helps in executing tests when the test suite and
data ﬁles are moved between environments and systems. This
option is enabled by default.

Allow
Comparator
Configuration

Controls the display of the ﬁeld that allows the selection of the
comparator and does not allow/disallow this during execution.

Allow client
side mock
factory objects

Enables the option of creating client side factory object that
do not need to be deployed on the server before executing test
cases. This option controls the display of the ﬁeld that controls
whether the mock factory objects are needed on the server or can
be pushed during the execution of the tests.

Display all
fields in the
expression
editor

Enables additional ﬁelds in the Expected Output section of a test
case. This option is useful if you want to check several output
conditions together.

Allow editing
of XML
(Effective after
reopen)

Enables editing of the XML source for the test suite. This option
requires that the open test suite ﬁle is closed and reopened
before its behavior reﬂects in the editor.

Allow scope
selection for
mocks

Enables scope selection for the mock. The default seing of
unchecked is appropriate for most test case scenarios.
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Preference

Description

Confirm delete
of single
objects

Enables the display of a conﬁrmation dialog box for every mock
service or data entry delete.

Confirm delete
of multiple
objects

Enables the display of a conﬁrmation dialog box when you
delete multiple mock service or data entries.

Confirm
service paste

Enables the display of a conﬁrmation dialog box when you paste
a test services.

License
The License preferences provide the license related information of Test Suite.
Preference

Description

License file

Allows you to select the license ﬁle for Test Suite.

Check License

Allows you to check the validity of the license ﬁle.

Editor
The Editor preference allows you to list the packages to load tot he service browser.
connection to webMethods Integration Server.
Preference

Description

Package Filter

Optional. Allows you to optionally enter a comma-separated
list of packages for Test Suite to load to the service browser.
When a large number of packages exist on the Integration Server,
this feature loads only those services for which test cases are
developed and thereby conserves memory in Test Suite.

Validation
The Validation preferences describe when and how Test Suite should validate the
information that you enter.
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Preference

Description

Validate on
Save

Allows Test Suite to validate the test suite prior to saving it to the
ﬁle system. This option is enabled by default.

Validate before
switching
mode

Allows Test Suite to perform validation of the test suite prior to
switching from the XML editor mode to the test suite editor.

Validate
against
schema

Allows Test Suite to validate the test suite against the XML
schema. This is useful if you use the XML Source tab to enter
details of one or more test cases in the suite. This option is
enabled by default.
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Before You Begin
Before creating a test suite, ensure that you organize the required test cases and data
ﬁles in a test folder.
If the test cases are packaged in the Integration Server package, it provides a common
source location for all related assets. You can import the package on eclipse workspace.
Example: Consider that the test cases are created in the resources test folder of the
Integration Server package.
While any organizational structure that conforms to Integration Server package
structure can be used, the following example provides a useful approach for organizing
test cases in your environment. For ease of organization, follow the steps below:
1. Right click the Resources directory and create a subdirectory under it called test.
2. Right-click the test directory and create two additional folders data and setup.
3. Add the test suites to the setup directory and organize the data directory using
subdirectories for each test suite to contain the input data ﬁles for the test cases
comprising a test suite.

To Create a Test Suite
Follow the below steps to create a test suite:
1. Navigate to resources> test> setup folder.
2. Select File>New> Test Suite.
3. On the webMethods TestSuite screen, enter the folder path that contains the test suite
setup ﬁles, provide a ﬁle name, and a suite name.
4. Click Finish.
You can now start creating the test cases.

Creating a Sample Test Suite
Designer allows you to create sample Test Suite projects.
1. Navigate to resources> test> setup folder.
2. Select File>New> Test Suite Example.
3. On the Sample wmTestSuite Project screen, enter the project name and location. You can
choose to use the default values.
This Test Suite familiarises you on building test cases.
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Adding a Test Case
Adding a test case involves the following steps:
1. Adding required test details. See “Test Details” on page 24.
2. Adding the required service details. See “Service Details” on page 24.
3. Deﬁning inputs to services. See “Inputs” on page 24.
4. Deﬁning the expected output. See “Expected Output” on page 25.

Test Details
To add test cases:
Right click on the webMethods Test Suite section.
The Test Details section appears in the details area to the right side of the display.
Provide a name and description for the test case.

Service Details
After creating the test details, you can now select the service to be tested.
1. Click Browse in the Service Details section to enable searching for the service within
the Integration Server.
Note:

2. Click

You can narrow the search by entering a package name or service name
and the service browser will restrict the display to only those packages or
services matching the search criteria entered.
to refresh or set additional options for service browser.

Inputs
Test Suite looks at the service signature for services in the Integration Server. When
deﬁning the inputs to the service selected in “Service Details” on page 24
Click Edit to modify the values of the input parameters and click OK to save the
changes.
Click Save... to save the ﬁle in the location designated for the input data after
deﬁning the input.
Click Load to import a saved input data.
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Click Browse to add a saved ﬁle as the input to the service.

Expected Output
The ﬁnal step in deﬁning a test case is to complete the Expected Output section.
Expected Output can be in the form of data returned from the service or an exception
returned from the service.
Use the class browser to deﬁne an exception or error output from the service. Click
Browse to display the classes and select the proper exception class to use.
To deﬁne the data output from the service, use the following methods:
Use XPath expressions to deﬁne which data elements in the output data should be
evaluated.
1. Copy the XPath expressions from Software AG Designer. To copy the XPath
expression, right click on the variable in the Results area when executing the
service within Software AG Designer and select Copy.
2. Click

,

, or

and paste the copied value into the XPath ﬁeld.

An entry for the variable selected is created. However, it in most cases it is not
required to edit them as the webMethods paths are 0 index based whereas XPath
expressions are 1 index based.
3. Enter the expected output for the ﬁeld in the Value ﬁeld.
You can select AND, OR, parentheses, and operators from the drop-down lists to
create complex evaluations of the output.
Use regular expressions to evaluate the output returned from the service. The
regular expression should be placed in the Value ﬁeld preceded and followed by "/"
character.

Output Comparison
Unit Test Framework allows you to select predeﬁned or customize the output
comparison to compare service results and check the destination table to conﬁrm the
operation executed successfully.
Prerequisite

For the Output Comparison secon to appear on the webMethods TestSuite screen,
ensure that you select the Display all comparators opon on the Preferences dialog
box. To select Allow Comparator Configuration, navigate to Window > Preferences >
Sotware AG > webMethods TestSuite > Advanced.
1. On the Output Comparison section, select Comparator Type.
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2. Select one of the following options:
Select...

To...

Default

Compare the actual and expected service result without
any ﬁlter.

Ignore Namespace
Prefix

Ignore the namespace preﬁx from the service results.

Use Field Alias

Specify which ﬁelds in the service result should be
compared.

For example, for a ﬁeld value demotest:employee in the
actual result, where demotest is the namespace preﬁx,
Unit Test Framework ignores the namespace and uses
employee for comparison.

You have to provide a ﬁeld alias for the ﬁeld in the actual
result that you want to Unit Test Framework to compare
against in the expected output.
For example, for a ﬁeld value demotest:employee
in the actual result, you can assign a 1002 as the ﬁeld
alias. Then, Unit Test Framework uses 1002 instead of
demotest:employee for comparison.

Custom

Click

to add the list of ﬁelds to compare.

Click

, or

to edit or delete the entries.

Specify a custom comparator for expected output other
than provided with the plug-in.

webMethods Unit Test Framework Help Version 10.5

26

M

Odd Header
Generating Tests

5

Generating Tests

■ Generating Tests Suites using Service Execution Results ..........................................................

webMethods Unit Test Framework Help Version 10.5

28

27

M

Even Header
Generating Tests

Generating Tests Suites using Service Execution Results
Test Suite allows you to generate tests from the details of recently run services present
in the Result view. Using the Generate Test icon
on the Results view, you can export
the available service invoke or run details to form a unit test and save in a Test Suite.
Ensure that you have installed the Test SuiteDesigner plugin.
1. In the Service Development perspective, navigate to the Results view of recently run
services and select the service for which you want to generate a test.
Note:
2. Click

For details on viewing the Results view, see the Software AG Designer
Online Help.
.

3. In the Export Pipeline dialog box, provide the following details and click Finish.
Type

Function

Container

Speciﬁes the project or directory location of the
Test Suite.
Ensure that you use an organizational structure
that conforms to Integration Server package
structure.
Ensure that the speciﬁed project exists in the
workspace.

TestSuite

Speciﬁes the name of the TestSuite ﬁle.
Use Overwrite to rebuilt the Test Suite. This
overwrites the existing Test Suite.
Use Append to append to the existing Test Suite.
Note: Ensure that you provide the ﬁlename with
the extension. For example, wmTestSuite.xml .

Input

Speciﬁes the service input ﬁle location.
Note: You can choose to retain the default value.

Output

Speciﬁes the expected output ﬁle location.
Note: You can choose to retain the default value.
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The Test Suite is created at the speciﬁed location.
4. Double click the newly created Test Suite.
The test details are displayed. You can edit the test details. To edit the test details,
see .
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Using Mocks
Mocks are used when resources that a service may require to properly execute may not
be available when a test case or test suite is developed or executed. Mocks provide a
means of simulating interaction with resources that are unavailable.
To create a mock
1. Expand the test case for which you want to deﬁne the mock, right click on Mocks and
select Add.
2. Click Browse and use the Service Browser to select the service to be mocked.
3. Enter the ﬁrst few characters of the service name to reduce the list. Click to refresh
the list and access preferences for the Service Browser.
4. Select the required Lifetime.
Valid selections are test (mock is eﬀective only for the selected test case) and suite
(mock will be eﬀective for all of the test cases that follow in the test suite).
5. Select the required Type.
Following are the valid selections:
Type

Function

pipeline

Intercepts the service and returns the speciﬁed
pipeline (for details on creating or editing pipeline
data see “Inputs” on page 24).

service

Intercepts the service and substitutes the selected
service with a call (for details on working with the
Service Browser, see “Service Details” on page 24).

exception

Intercepts the service and returns an exception
(for details on selecting exception classes, see
“Expected Output” on page 25).

factory

Intercepts a call to the mocked service and returns
the data based on the input (for details on creating
a mock factory, see “Sample Mock Factory” on
page 33).

6. Select the scope.
It is recommended to use the session scope for most purposes. To allow the scope
selection, select the corresponding preference.
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Sample Mock Factory
The following code snippet illustrates the minimum requirements for creating a mock
factory. The factory class and any other classes should be designed to evaluate the
input data to the factory and return data relevant to that input in an IData format. The
example below returns static data.
package com.wm.ps.serviceMock.samples;
import com.wm.app.b2b.server.BaseService;
import com.wm.app.b2b.server.invoke.ServiceStatus;
import com.wm.data.IData;
import com.wm.data.IDataFactory;
import com.wm.ps.serviceMock.MockDataFactory;
public class SampleMockDataFactory implements MockDataFactory
{
private static final long serialVersionUID = 2L;
public IData createData(BaseService baseService, IData pipeline,
ServiceStatus serviceStatus)
{
IData[] results = new IData[]{IDataFactory.create(new Object[][]{
{"originationSource","W"},
{"bizType","RT"},
{"lockExpirationDate","20050427"},
{"floatLoanIndicator","Y"},
{"uwFinalDecisionCode","0"},
{"uwDecisionExpiryDate","20050427"},
{"canDate","20050427"},
{"loanCloseStatusType","T"},
{"fileReceivedAtRocDate","20050221"},
{"loanReadyToFundIndicator","P"},
{"regisDate","20051221"},
{"loanSubmitToUwDate","20050427"},
{"loanNumber","0000000001"},
{"branch","TOTAL ADVANTEDGE LLC
"},
{"underwritingDecisionCode","0"},
{"underwritingDecisionExpirationDate","20050427"},
{"lockDate","20051220"},
{"lockIndicator","Y"},
{"tmoLoanStageCode","3"},
{"tmoLoanStageDate","20050427"},
{"product","C30
"},
{"borrowerFirstName",".
"},
{"borrowerLastName","XX
"},
{"propertyAddress","937 S MEYER
"},
{"propertyCity","TUCSON
"},
{"propertyState","AZ"},
{"propertyZip","85701"}
})};
IData output = IDataFactory.create(new Object[][]{{"results", results}});
return IDataFactory.create(new Object[][]{{"getPotentialDuplicatesOutput",
output}});
}
}
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Mocks beyond Unit Testing
Although Test Suite added the ability to mock service calls in Integration Server for unit
testing, the feature is so powerful that its use cannot be limited to unit testing alone. One
common case is to use the mocking capability to provide ﬂow service instrumentation.
Using the wm.ps.serviceMock:loadMock service in the WmServiceMock package, any
service can be mocked with an alternate service or class. The new service or Java class
code can invoke any operations and then invoke the original mocked service. The
mocking framework is intelligent enough to detect recursion and, as such, provides an
instrumentation capability.
Mocks can be used to design test cases. A service being tested can also itself be mocked
with other code. In such a scenario, the mocked test service can be replaced with
other code that can execute pre and post-test operations. This can provide some basic
functional testing capabilities for Test Suite.
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Pipeline Filter
The execution of test cases is initiated as a client to the Integration Server hosting the
services to be tested. For this reason, the inputs supplied to the service during execution
and the expected outputs need to be serialized over the client-server interaction. If the
input or output pipeline contains non-serializable objects, these objects are either lost or
seen incorrectly during test execution. In addition, the service input needs to be more
dynamic in nature than the static pipeline setup in the test case. Pipeline Filter helps to
resolve these issues.
The Pipeline Filter is set once for the entire suite and provides a callback mechanism
for the test developer to inject code that can modify various pipeline objects during
execution. The Pipeline Filter is a class that implements the com.wm.ps.test.PipelineFilter
interface and enables a user to add, remove, or change variables in the pipeline that are
created from ﬁles, as pipelines created from ﬁles may not be able to persist custom java
objects. The output pipeline from a service can also be ﬁltered using the appropriate
method. Only one such instance of the implementing class is created for the test suite
and the name of test case is passed as a parameter.
The pipeline ﬁlter can be setup for the test suite in the main panel for the suite
parameters.

Comparators
Comparator provides an extension that can be used to extend, enhance, or replace the
standard comparison of expected output.
Each test suite can have its comparator that can be speciﬁed from the user interface.
Custom comparators are Java classes that implement the com.wm.ps.test.ResultsValidator
interface.
Comparators also provide a mechanism to execute operations pre and post service
execution. Using comparators you can build some basic functional testing capability. For
example, if a service writes to a database table, a comparator can compare the results
from the service and check the destination table to conﬁrm the operation executed
successfully. You can also specify ﬁlters while comparing.

Client Mock Factory
The beneﬁt of using a mock factory object as opposed to a service is that it provides a
light-weight alternative that does not require the creation of a new service on the server.
Test Suite provides an option to dynamically push the classes needed for supporting the
mock factory on the server during test execution. This option can be used to avoid the
need for frequent restart when Java objects are changing. Once stabilized, it would be
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helpful to deploy the code to the server as this feature is experimental in nature and will
only work if the dependency tree is not too complex. Using the user interface, you can
set the option to dynamically push the objects to the server.
If the option is disabled, enable the corresponding preference as discussed in the
Advanced section.
webMethods expression

JXPath equivalent

PosRequest/ns:Log/ns:Transaction[0]/@Flag

PosRequest[@name='ns:Log']
[@name='ns:Transaction'][1]
[@name='@Flag']

PosRequest/ns:Log/ns:Transaction[0]/
ns:BUnit[0]/ns:ID/*body

PosRequest[@name='ns:Log']
[@name='ns:Transaction']
[1][@name='ns:BUnit'][1]
[@name='ns:ID'][@name='*body']

XPath Expressions
The XPath expressions used in the expected output panel are diﬀerent from the usual
webMethods path expressions. As mentioned in the “Expected Output” on page 25
section, the indices start at 1 instead of the 0 based webMethods indices.
Test Suite uses JXPath for evaluating XPath expressions. For details on JXPath
expressions, visit “hp://commons.apache.org/jxpath/”. Special characters such as '@'
and ':' in the name have special meaning in JXPath expressions hence, you should use
special syntax variant to use these characters in variable name.
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Test Suite Internals
In Software AG Designer, test suite editor provides a user interface to graphically and
quickly develop test cases for Integration Server services. The test suite and the test
cases are saved in an XML ﬁle. The Software AG Designer editor allows editing the XML
source directly, provided that the user is aware of the format and the associated schema.
It is not recommended to edit the XML ﬁle as it is error-prone. It provides the option
to automate the creation of test cases automatically by using code to generate the XML
ﬁle directly. One such use case is the scenario where service inputs and outputs have
been captured in an environment and test cases have to be generated to use these ﬁles
for regression testing.
A sample XML test suite ﬁle in its simpliﬁed form can be as shown in the ﬁgure below:
<?xml version="1.0" encoding="UTF-8"?>
<webMethodsTestSuite description=
"Sample tests for the WmServiceMockSamples implementation" name="Sample Tests">
<webMethodsTestCase description=
"Duplicate Check Success with IData results" name="Duplicate Check Success
With Results">
<mock folder="wmServiceMockSamples.data.services"
name="getPotentialDuplicates">
<pipeline filename="resources/test/data/
mockDupCheckOutputResults.xml"/>
</mock>
<service folder="wmServiceMockSamples.services" name="getDuplicateLoans">
<input>
<file filename="resources/test/data/dupCheckInput.xml"/>
</input>
<expected>
<file filename="resources/test/data/
dupCheckSuccessWithResults.xml"/>
</expected>
</service>
</webMethodsTestCase>
<webMethodsTestCase description=
"Duplicate Check Failure handled by the catch block" name="Duplicate Check
Catch Block">
<mock folder="wmServiceMockSamples.data.services"
name="getPotentialDuplicates">
<exception class="java.lang.IllegalArgumentException"
message="Bad argument"/>
</mock>
<service folder="wmServiceMockSamples.services" name="getDuplicateLoans">
<input>
<file filename="resources/test/data/dupCheckInput.xml"/>
</input>
<expected>
<exception class="java.lang.IllegalArgumentException"
message="Bad argument"/>
</expected>
</service>
</webMethodsTestCase>
</webMethodsTestSuite>
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Java Unit Tests
Test Suite Java API allows you to create pure JUnit test cases that can provide the same
features that a user interface driven codeless test cases do.
The change when creating a Test Suite JUnit test case from the traditional test case is that
the implementing class extends com.wm.ps.test.WmTestCase instead of junit.framework.TestCase.
com.wm.ps.test.WmTestCase does extend the junit.framework.TestCase. The two important
methods that are needed for creating test cases using the java API are:
invokeService – The method to invoke a service on the server
mockService – There are various variants of this method that allow the user to setup
a mock for a service on the server.
A sample JUnit test case is provided here:
package com.wm.ps.serviceMock.samples;
import com.wm.data.*;
import com.wm.ps.test.*;
public class DuplicateCheckTest extends WmTestCase
{
public void testDupCheckCatchBlock() throws Exception
{
IData input = IDataFactory.create(new Object[][]{
{"lienType", "1"},
{"borrowerSSN", "111-11-1111"},
{"propertyAddress", "937 S Meyer"},
{"propertyZip", "85701"}
});
String exceptionText = "Bad argument";
mockService("wmServiceMockSamples.data.services",
"getPotentialDuplicates", new
IllegalArgumentException(exceptionText));
try
{
invokeService("wmServiceMockSamples.services",
"getDuplicateLoans", input);
assertFalse(true); //Control getting here means failure
}
catch (Exception e)
{
assertTrue(e.getMessage().endsWith(exceptionText));
}
}
public void testDupCheckSucessWithResults() throws Exception
{
IData input = IDataFactory.create(new Object[][]{
{"lienType", "1"},
{"borrowerSSN", "111-11-1111"},
{"propertyAddress", "937 S Meyer"},
{"propertyZip", "85701"}
});
IData mockOutput =
WmTestSuiteUtils.getIDataFromFile("resources/test/data/
mockDupCheckOutputResults.xml");
mockService("wmServiceMockSamples.data.services", "getPotentialDuplicates",
mockOutput);
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}

}

IData output = invokeService("wmServiceMockSamples.services",
"getDuplicateLoans",
input);
IDataCursor outCursor = output.getCursor();
IData response = IDataUtil.getIData(outCursor, "response");
IDataCursor responseCursor = response.getCursor();
String creationTime = IDataUtil.getString(responseCursor, "@creationTime");
assertNotNull(creationTime);
assertEquals(28, creationTime.length());
IData[] duplicateLoans = IDataUtil.getIDataArray(responseCursor,
"duplicateLoans");
assertEquals(duplicateLoans.length, 1);
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Executing Test Cases
To execute test cases created with Test Suite, right click in the webMethods Tests section
and select one of the following options:
Run Tests - executes the selected test case, using the mocks that are deﬁned for the
test case.
Run Test with Mocks Disabled - executes the selected test case by disabling the mocks
deﬁned for the test case.
Disable Test - marks test case as disabled. Tests are not executed until it is enabled
again.
Disable Mocking in Tests - marks mocks deﬁned for selected test as disabled. Mocks are
not executed until they are enabled again.
Add - adds another test case to the suite.
Insert - inserts another test case to the suite after the selected test case.
Remove - removes the selected test case from the suite.

Executing Test Suites
To execute test suites created using Test Suite, right click in the webMethods Tests
section and select one of the following options:
Run Suite - executes the selected test suite, using the mocks that are deﬁned for the
test suite.
Run Suite with Mocks Disabled- executes the selected test suite by disabling the mocks
de-ﬁned for the test suite.
Disable Suite - marks test suite as disabled. The test suite is not executed until it is
enabled again.
Disable Mocking in Suite - marks mocks deﬁned for this suite as disabled. Mocks are
not executed until they are enabled again.
Shift Up or Shift Down - changes the order of test cases in the test suite by shifting the
selected test case up or down in the test suite.

Debugging Java Code
Various components in Test Suite rely on Java code.
Example: Java mock factory and pipeline ﬁlter classes.
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Use the Debug menu to debug a Java code. The support library jar ﬁles also have source
code associated with them. Debugging into the source can be helpful to understand
the internals of the test execution or to enhance capabilities new features like custom
comparators.

Continuous Integration
For continuous integration you can invoke headless tests through Test Suite Executor
which provides default Ant script to start with.

Creating a Test Suite Executor
Software AG Designer allows you to create Test Suite executor projects and execute tests
in headless mode.
Perform the following steps to create a sample test suite executor using the default ﬁles.
1. Select File>New> Test Suite Executor.
2. On the Test Suite Executor Project screen, enter the project name, folder path that
contains the test suite setup ﬁles, and the ﬁle system. You can choose to use the
default values.
3. Click Finish.
Project contains default Ant build targets and properties to drive the tests.

Configuring a Test Suite Executor
Software AG Designer allows you to conﬁgure Test Suite executor after you have
successfully created the projects.
Perform the following steps to conﬁgure a sample test suite using the default ﬁles.
1. To initiate the tests, use the ant build ﬁle, run-composite-runner.xml and ant target,
composite-runner-all-tests.
2. Modify the properties ﬁle, run-test-suites.properties to specify project locations and
seing up target Integration Server deﬁnition.
3. Specify the following properties in the run-test-suites.properties ﬁle.
Name

Description

webMethods.integrationServer.name

Speciﬁes the Integration Server host name.
For example: localhost, 27.0.0.1

webMethods.integrationServer.port
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Name

Description
For example: 5555

webMethods.integrationServer.userid

Speciﬁes the Integration Server user name.
For example: Administrator, Developer

webMethods.integrationServer.password Speciﬁes the Integration Server user

password.

For example: manage
webMethods.integrationServer.ssl

Speciﬁes the Integration Server port uses
SSL connection or normal.
For example: false or true

webMethods.home

Speciﬁes the product installation location.
For example: C\:\\SoftwareAG

webMethods.test.setup.location

Speciﬁes multiple project locations
(absolute directory path) in
$AbsoluteProjectLocation1,
$AbsoluteProjectLocation2,
$AbsoluteProjectLocation3 format. In this
case, Test Suite Executor searches for all
available and valid WmTestSuite ﬁles in
these directories.
For example:
C:/SoftwareAG/IntegrationServer/
instances/default/packages/
SampleTestSuite,C:/_gitRepo/packages/
SampleTestSuite1.
It executes speciﬁc and multiple
WmTestSuite ﬁles by specifying
it in the following format:
$AbsoluteProjectLocation1;
$RelativeTestSuitePath1,
$AbsoluteProjectLocation2;
$RelativeTestSuitePath2.
For example :
C:/SoftwareAG/IntegrationServer/
instances/default/packages/
SampleTestSuite;resources/test/setup/
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Name

Description
wmTestSuite.xml,C:/_gitRepo/packages/
SampleTestSuite1;resources/test/setup/
wmTestSuite.xml

webMethods.test.setup.external.classpath.layout
Speciﬁes the relative paths within the

projects where required classes or jar
ﬁles are expected to be in Test Executor
build-classpath. For example, when thirdparty libraries or Mockfactory classes
are referred from the Tests, specify the
locations where these are stored at, so
that executor can load these dependencies
during headless tests. Append the default
comma separated list if required.
Default value: resources/test/
classes,resources/java/classes,resources/
test/jars,resources/java/jars,resources/jars

webMethods.test.profile.result.location
Speciﬁes the absolute directory location

where the reports are stored.

For example: C\:/git_sources/GitRepo3/
WmTestSuiteExecutor/test/reports/
Note:

Alternatively, you can also use the ant build ﬁle run-test-suites.xml
and target runall-test. Test Suite Executor cleans and builds the projects
included in target runall-test, then searches for the TestSuites and
executes. List of projects can be included within runall-test target (under
dirset contents). Reports are generated at the following default location:
$basedir/test/reports. To use runall-test, the test projects or packages has to
conform to the default project layout. Refer to the SampleTestSuite for the
default project layout.
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Running a Coverage Analysis
Unit Test Framework allows you to record and analyze which ﬂow steps and map
actions of your ﬂow service(s) are executed during a particular test launch. It helps to
identify untested steps and improve the corresponding tests.
Pre-requisites:
Before running the test coverage analysis, ensure that you activate the wM Code
Coverage Agent. To activate the wM Code Coverage Agent, perform one of the
following steps:
On the Package Navigator right-click the default Integration Server instance and
select wM Code Coverage Agent > Activate
OR
1. In Designer, navigate to Window > Preferences > Software AG > Integration Server and
select the default server.
2. Click wM Code Coverage Agent.
3. On the wM Code Coverage Agent Seings dialog, select Activate.
.
To run a test coverage analysis
1. In the webMethods Tests section, right click and select wM Code Coverage Tools.
2. Select one of the following:
Run Suite: executes the selected test suite.
Run Suite with Mocks disabled: executes the selected test suite with Mocks disabled.
Run Tests: executes the selected test case.
Run Tests with Mocks disabled: executes the selected test case with Mocks disabled.
The test or suite coverage analysis appear as a graphical data under the wM Code
Coverage view.

Viewing Code Coverage Analysis
After you run the test, wM Code Coverage view displays a detailed coverage report of
the test session.
The tested ﬂow steps and map actions or Services appear in green and the untested ﬂow
steps and map actions appear in red.
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To view the code coverage analysis
1. On the wM Code Coverage view, perform one of the following:
Click...

To..

Show Full Packages
View

Represent elements under the corresponding Packages
and Service namespace. This View provides detailed
coverage analysis of the ﬂow steps and map actions of all
the individual service(s) under test in the test suite.

Show Execution
Model View

Represent elements based on invocation hierarchy. This
View provides individual test coverage analysis of the
ﬂow steps and map actions of the individual service(s)
involved in the test case.

Show Service Level
View

Represent only Invoked Services as elements under
corresponding Packages. This view provides the
coverage analysis of only the services invoked during
the test case or test suite execution.
Exclude System Packages:
Hides all the Integration Server Core Packages from the
Report.

Show All Entries

Displays full coverage details.
This is default selection.

Hide Missed Entries

Hides the untested parts of test coverage
This does not eﬀect the Coverage percentage.

Hide Covered
Entries

Hides the tested parts of test coverage.
This does not eﬀect the Coverage percentage.

Defining the Coverage Scope
Unit Test Framework allows you to edit and redeﬁne the scope of a test coverage
session. To achieve this, you can edit an existing launch conﬁguration or create one.
You can select packages that you want to include under the coverage purview. Flow
elements and services belonging to the selected packages determine the coverage
percentage.
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To create a launch configuration
1. In the webMethods Tests section, right click and select wM Code Coverage Tools.
2. Click Code Coverage Launch Configurations....
3. On the Code Coverage Launch Conﬁgurations box, select wM Code Coverage and click
to add a new launch conﬁguration.
4. Enter a name in the Name ﬁeld and a project name in Project ﬁeld.
5. On the Test tab, enter the following information:
Field

Description

Project

Speciﬁes the project name for..... You can click Browse...
to select from the

Test Suite

Speciﬁes the test suite path. You can click Search... to
select from a list of valid test suite ﬁles in the speciﬁed
Project.

Test Method

Optional. Speciﬁes the test name. You can click Search...
to fetch the list of tests from the speciﬁed test suite. If
this ﬁeld is left blank, all the tests are selected.

6. On the Project Filter tab, perform the following
Field

Description

Server Node

Speciﬁes the server node name. You can select the
Default server node to list all the available packages
from the server.

Proﬁler Scope

Deﬁnes the scope of coverage analysis for the launch.
You can select the required packages from the list.

7. Click wM Code Coverage Tools.
The coverage analysis appear as a graphical data under the wM Code Coverage view.

Coverage Analysis in Headless Mode
Test Suite Executor (see “Creating a Test Suite Executor” on page 47 ) provides the Ant
build ﬁle run-composite-runner.xml with necessary tasks and properties to start a test.
Use the task composite-runner-all-tests for headless test execution to generate code
coverage analysis report.
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Specify the following properties:
Name

Description

webMethods.test.setup.profile.mode

Sets to Coverage to generate coverage
report. Set to None for regular test
execution.

webMethods.test.scope.packages

Speciﬁes the list of comma separated
target Integration Server package
names. This Deﬁnes the full scope for
the coverage analysis and percentage
calculation.
Example:
SampleTestSuite,SampleTestSuite1
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WmServiceMock Services
The services in the WmServiceMock package deal with the mocking aspects of testing.
These services provide a way to enable or disable mocks for individual services or
server-wide.
wm.ps.serviceMock:loadMock
Sets up mocking for a service.
Inputs

scope

session, user, or server. The default is session.

service

The name of the service to be mocked. No validation is
performed on the name of the server or its existence.

mockObjectThe mockObject is an object type. The behavior of the mock
is controlled by the type of the actual object.
Inputs

java.lang.String

The name of
the alternate
service to
mock the
mocked
service with.

java.lang.Exception

The exception
to be thrown
for the
mocked
service.

com.wm.data.IData

The ﬁxed
pipeline to
return for
the mocked
service

com.wm.ps.serviceMock.MockDataFactory

The
implementation
of the factory
objects that
creates the
dynamic
pipeline for
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wm.ps.serviceMock:loadMock
the mocked
service.
parms

Optional document containing all extra parameters for
the alternate service. This parameter is only needed when
mocking a service with an alternate service and the alternate
service needs additional inputs.

Outputs None
wm.ps.serviceMock:clearMock
Removes mocking for a service.
Inputs

Outputs

scope

session, user or server. The default is session.

service

The name of the service to be mocked. No validation is
performed on the name of the server or its existence.

None

wm.ps.serviceMock:clearAllMocks
Removes mocking for all services.
Inputs

None

Outputs

None

wm.ps.serviceMock:suspendMocks
Suspends mocking for all services.
Inputs

None

Outputs

None
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wm.ps.serviceMock:resumeMocks
Resumes mocking for all services, for which it was suspended.
Inputs

None

Outputs

None

wm.ps.serviceMock:getMockedServices
Retrieves the list of services that are currently mocked in all the scopes.
Inputs

None

Outputs

mockedServices The list of services that are currently mocked in the
session, user, or server scope.

References
Javadoc API Reference - The javadoc reference for the Test Suite java API. This is
useful for advanced Test Suite features as well as creating pure java unit tests for
Integration Server services.
“JXPath”– Documentation for JXPath API
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